
Sun Java System Connector for
Microsoft Outlook 7 2005Q4

Administration Guide

Sun Microsystems, Inc.
4150 Network Circle
Santa Clara, CA 95054
U.S.A.

Part No: 819–2566–10
October 2005



Copyright 2005 Sun Microsystems, Inc. 4150 Network Circle, Santa Clara, CA 95054 U.S.A. All rights reserved.

This product or document is protected by copyright and distributed under licenses restricting its use, copying, distribution, and decompilation. No
part of this product or document may be reproduced in any form by any means without prior written authorization of Sun and its licensors, if any.
Third-party software, including font technology, is copyrighted and licensed from Sun suppliers.

Parts of the product may be derived from Berkeley BSD systems, licensed from the University of California. UNIX is a registered trademark in the U.S.
and other countries, exclusively licensed through X/Open Company, Ltd.

Sun, Sun Microsystems, the Sun logo, docs.sun.com, AnswerBook, AnswerBook2, Java, and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries. All SPARC trademarks are used under license and are trademarks or registered trademarks of
SPARC International, Inc. in the U.S. and other countries. Products bearing SPARC trademarks are based upon an architecture developed by Sun
Microsystems, Inc.

The OPEN LOOK and Sun™ Graphical User Interface was developed by Sun Microsystems, Inc. for its users and licensees. Sun acknowledges the
pioneering efforts of Xerox in researching and developing the concept of visual or graphical user interfaces for the computer industry. Sun holds a
non-exclusive license from Xerox to the Xerox Graphical User Interface, which license also covers Sun’s licensees who implement OPEN LOOK GUIs
and otherwise comply with Sun’s written license agreements.

U.S. Government Rights – Commercial software. Government users are subject to the Sun Microsystems, Inc. standard license agreement and
applicable provisions of the FAR and its supplements.

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,
INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE
DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Copyright 2005 Sun Microsystems, Inc. 4150 Network Circle, Santa Clara, CA 95054 U.S.A. Tous droits réservés.

Ce produit ou document est protégé par un copyright et distribué avec des licences qui en restreignent l’utilisation, la copie, la distribution, et la
décompilation. Aucune partie de ce produit ou document ne peut être reproduite sous aucune forme, par quelque moyen que ce soit, sans
l’autorisation préalable et écrite de Sun et de ses bailleurs de licence, s’il y en a. Le logiciel détenu par des tiers, et qui comprend la technologie relative
aux polices de caractères, est protégé par un copyright et licencié par des fournisseurs de Sun.

Des parties de ce produit pourront être dérivées du système Berkeley BSD licenciés par l’Université de Californie. UNIX est une marque déposée aux
Etats-Unis et dans d’autres pays et licenciée exclusivement par X/Open Company, Ltd.

Sun, Sun Microsystems, le logo Sun, docs.sun.com, AnswerBook, AnswerBook2, Java et Solaris sont des marques de fabrique ou des marques
déposées, de Sun Microsystems, Inc. aux Etats-Unis et dans d’autres pays. Toutes les marques SPARC sont utilisées sous licence et sont des marques
de fabrique ou des marques déposées de SPARC International, Inc. aux Etats-Unis et dans d’autres pays. Les produits portant les marques SPARC sont
basés sur une architecture développée par Sun Microsystems, Inc.

L’interface d’utilisation graphique OPEN LOOK et Sun™ a été développée par Sun Microsystems, Inc. pour ses utilisateurs et licenciés. Sun reconnaît
les efforts de pionniers de Xerox pour la recherche et le développement du concept des interfaces d’utilisation visuelle ou graphique pour l’industrie
de l’informatique. Sun détient une licence non exclusive de Xerox sur l’interface d’utilisation graphique Xerox, cette licence couvrant également les
licenciés de Sun qui mettent en place l’interface d’utilisation graphique OPEN LOOK et qui en outre se conforment aux licences écrites de Sun.

CETTE PUBLICATION EST FOURNIE “EN L’ETAT” ET AUCUNE GARANTIE, EXPRESSE OU IMPLICITE, N’EST ACCORDEE, Y COMPRIS DES
GARANTIES CONCERNANT LA VALEUR MARCHANDE, L’APTITUDE DE LA PUBLICATION A REPONDRE A UNE UTILISATION
PARTICULIERE, OU LE FAIT QU’ELLE NE SOIT PAS CONTREFAISANTE DE PRODUIT DE TIERS. CE DENI DE GARANTIE NE
S’APPLIQUERAIT PAS, DANS LA MESURE OU IL SERAIT TENU JURIDIQUEMENT NUL ET NON AVENU.

050923@13215



Contents

Preface 7

1 Getting Started 13
Introduction and Orientation 13
Administrator’s Process Overview 14

� To Deploy the Connector for Microsoft Outlook 14

2 Configuring End-User Packages 17
Creating Desktop Installation Packages 17

� To create an end-user desktop installation package 17
Processes Tab 19

User mode 20
Processes to include in this configuration 20
Log file settings 21
Status file settings 22
Notes (optional) 22

User Profiles Tab 22
User profile settings 23
Option to save profile user password during configuration 26

User .psts Tab 26
General Settings for Personal Folder (.pst) Files 27
Exchange Profile Settings for .psts 27
IMAP/POP Profile Settings for .psts 28

Servers Tab 28
Settings 29

Mail Tab 30

3



Incoming Mail (IMAP) 31

Outgoing Mail (SMTP) 31

LDAP Tab 32

Global Address List 32

User Settings 34

Calendar Tab 34

Settings 35

Address Book Tab 35

Single User Tab 36

3 Application Notes for Special Circumstances 39

“Push” Method Deployment, If End Users Lack Installation Privileges 39

� To Deploy the Push Method 40

Command-Line Switches for the User Installation Package 45

Migrating Terminal Service Users from Exchange to the Sun Java System 46

� To Migrate Terminal Service Users from Exchange to Sun Java System 47

Designating Outlook as the Default Client 47

� To Designate Microsoft Outlook as a User’s Default Email Client 47

Removing Sun Java System Synchronization 48

� To Remove a Synchronization Program from a User’s Workstation 48

Undoing (Reversing) a User’s Migration 49

� To Reverse a User’s Migration 49

Index 51

4 Sun Java System Connector for Microsoft Outlook 7 2005Q4 Administration Guide • October 2005



Figures

FIGURE 2–1 Deployment Configuration Program: Configuration Window 18

FIGURE 2–2 Deployment Configuration Program: Processes Tab 19

FIGURE 2–3 Deployment Configuration Program: User Profiles Tab 23

FIGURE 2–4 Deployment Configuration Program: User .psts Tab 27

FIGURE 2–5 Deployment Configuration Program: Servers Tab 29

FIGURE 2–6 Desktop Deployment Configuration Program: Mail Tab 30

FIGURE 2–7 Deployment Configuration Program: LDAP Tab 32

FIGURE 2–8 Deployment Configuration Program: Calendar Tab 35

FIGURE 2–9 Deployment Configuration Program: Address Book Tab 35

FIGURE 2–10 Deployment Configuration Program: Single User Tab 36

FIGURE 3–1 Permission Settings (left) and Properties (right) for the LOGS Shared
Folder 41

FIGURE 3–2 SMS Distribute Software Wizard: Package Identification 42

FIGURE 3–3 SMS Distribute Software Wizard: Source Directory Screen 43

FIGURE 3–4 A User’s Advertised Programs Monitor 44

FIGURE 3–5 A User’s Countdown Dialog Box 44

5



6 Sun Java System Connector for Microsoft Outlook 7 2005Q4 Administration Guide • October 2005



Preface

This guide describes the Deployment Configuration Program for the Sun Java™
System Connector for Microsoft Outlook and how to create customized installation
and conversion packages for Microsoft Outlook end users.

Who Should Use This Book
You should read this book if you are responsible for administering and deploying Sun
Java System Connector for Microsoft Outlook at your site.

Before You Read This Book
This book assumes that you are responsible for administering and deploying
Connector for Microsoft Outlook software and that you have a general understanding
of the following:

� The Internet and the World Wide Web

� Sun Java System Calendar Server protocols and Sun Java System Messaging Server
protocols

� System administration and networking for the following:

� Microsoft Windows 2000
� Microsoft Windows XP

� Microsoft Outlook

� General deployment architectures
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How This Book Is Organized
This book contains the following chapters:

Chapter 1 explains what the Sun Java System Connector for Microsoft Outlook is
designed to do, how it is typically used within the context of an overall migration
scenario, and what you should do to get started with the software including
instructions for installing the administrator’s software on your own computer.

Chapter 2 describes how to use the Deployment Configuration Program to create
customized packages for Outlook end users. Depending on your circumstances, you
can configure these packages to install the necessary software, to convert existing
Microsoft Outlook and Exchange data files for use with the new Connector for
Microsoft Outlook, or both.

Chapter 3 explains how to deploy Connector for Microsoft Outlook under certain
special circumstances or network configurations.

Connector for Microsoft Outlook
Documentation Set
The following table summarizes the books included in the Connector for Microsoft
Outlook core documentation set.

TABLE P–1 Books in This Documentation Set

Book Title Description

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Deployment Planning
Guide

Describes the administrator’s process and
strategies for deploying Connector for Microsoft
Outlook to end-user desktops.

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Installation Guide

Describes how to install the administration
software that helps an administrator deploy
Connector for Microsoft Outlook to end-user
desktops.

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Administration Guide

(This guide) Describes the administrator’s
deployment configuration program for the
Connector for Microsoft Outlook.
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TABLE P–1 Books in This Documentation Set (Continued)
Book Title Description

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 User’s Guide

Explains how to install, use, and configure the
Connector for Microsoft Outlook on your
desktop. This guide also describes the user
interface.

Sun Java System Communications
Services 2005Q4 Release Notes

Contains last-minute information, new features,
known problems and limitations, installation
notes, and how to report issues with the software
or the documentation.

Related Books
For other server documentation, go to the following:

� Sun Java System Messaging Server documentation
(http://docs.sun.com/coll/1312.1)

� Sun Java System Calendar Server documentation
(http://docs.sun.com/coll/1313.1)

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–2 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 A placeholder to be replaced with a real
name or value

The command to remove a file
is rm filename.
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TABLE P–2 Typographic Conventions (Continued)
Typeface Meaning Example

AaBbCc123 Book titles, new terms, and terms to be
emphasized (note that some emphasized
items appear bold online)

Read Chapter 6 in the User’s
Guide.

A cache is a copy that is stored
locally.

Do not save the file.

Shell Prompts in Command Examples
The following table shows default system prompts and superuser prompts.

TABLE P–3 Shell Prompts

Shell Prompt

C shell on UNIX and Linux systems machine_name%

C shell superuser on UNIX and Linux systems machine_name#

Bourne shell and Korn shell on UNIX and Linux systems $

Bourne shell and Korn shell superuser on UNIX and Linux systems #

Microsoft Windows command line C:\

Symbol Conventions
The following table explains symbols that might be used in this book.

TABLE P–4 Symbol Conventions

Symbol Description Example Meaning

[ ] Contains optional
arguments and
command options.

ls [-l] The -l option is not required.
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TABLE P–4 Symbol Conventions (Continued)
Symbol Description Example Meaning

{ | } Contains a set of choices
for a required command
option.

-d {y|n} The -d option requires that you
use either the y argument or the
n argument.

${ } Indicates a variable
reference.

${com.sun.javaRoot} References the value of the
com.sun.javaRoot variable.

- Joins simultaneous
multiple keystrokes.

Control-A Press the Control key while you
press the A key.

+ Joins consecutive
multiple keystrokes.

Ctrl+A+N Press the Control key, release it,
and then press the subsequent
keys.

→ Indicates menu item
selection in a graphical
user interface.

File → New →
Templates

From the File menu, choose
New. From the New submenu,
choose Templates.

Accessing Sun Resources Online
The docs.sun.comSM web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. Books are available as online files in PDF and HTML formats. Both formats are
readable by assistive technologies for users with disabilities.

To access the following Sun resources, go to http://www.sun.com:

� Downloads of Sun products
� Services and solutions
� Support (including patches and updates)
� Training
� Research
� Communities (for example, Sun Developer Network)

Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related
information.

11

http://docs.sun.com
http://www.sun.com


Note – Sun is not responsible for the availability of third-party web sites mentioned in
this document. Sun does not endorse and is not responsible or liable for any content,
advertising, products, or other materials that are available on or through such sites or
resources. Sun will not be responsible or liable for any actual or alleged damage or
loss caused or alleged to be caused by or in connection with use of or reliance on any
such content, goods, or services that are available on or through such sites or
resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Send
Comments. In the online form, provide the full document title and part number. The
part number is a 7-digit or 9-digit number that can be found on the book’s title page or
in the document’s URL. For example, the part number of this book is 819-2566.
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CHAPTER 1

Getting Started

The Sun Java System Connector for Microsoft Outlook enables users in your
organization to use Microsoft Outlook as their email and calendar client while
connected to Sun Java System servers. The Connector for Microsoft Outlook must be
installed and configured on each user desktop to facilitate the necessary ongoing
communications between Microsoft Outlook and the Sun Java System server. The
Connector for Microsoft Outlook software is installed one desktop at a time by a Setup
Wizard that can also convert any existing Microsoft Outlook data files to a format that
the new software can read and use.

Introduction and Orientation
To simplify both the administrator’s work associated with deployment and the user’s
tasks in actually installing and configuring the new software, Sun provides a
Deployment Configuration Program. This tool lets the administrator create
customized end-user installation packages for the software, with pre-set configuration
parameters to simplify and streamline the user’s process, and to enforce any
configuration settings the administrator deems necessary or desirable for a particular
user or group of users. The Deployment Configuration Program saves those pre-set
configuration parameters in an .ini text file, and then bundles the .ini file with an
installation program—the Setup Wizard—for end users. When an end user activates
the package, the Setup Wizard reads the .ini file to install and configure the
Connector software on the user’s desktop according to the administrator’s
specifications.

A system administrator may create different installation packages for different
individual users, or for different groups of end users—for example, to enforce different
configuration schemes for users in the Sales department vs. the Engineering
department and so forth, or to offer configuration options to some groups of users
while setting fixed parameters (eliminating the choices) for others.
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Administrator’s Process Overview
In a typical deployment scenario, an administrator will perform four primary tasks to
deploy the Sun Java System Connector for Microsoft Outlook.

� To Deploy the Connector for Microsoft Outlook

1. Prepare a comprehensive Deployment Plan.

Planning and foresight are critical to a smooth deployment. The process of
developing a comprehensive Deployment Plan is a valuable exercise that will lead
you to consider and accommodate all of the factors likely to influence your
organization’s migration. The Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Deployment Planning Guide explains important migration
concepts, prerequisites, and strategic choices, and explains how to develop a
Deployment Plan that will guide you through your migration. Every administrator
should therefore read the Sun Java System Connector for Microsoft Outlook 7 2005Q4
Deployment Planning Guide and prepare a comprehensive Deployment Plan.

2. Install the Deployment Configuration Program.

Sun’s administrative software obviously must reside on the administrator’s
computer before it can be used to create end-user installation packages. The
installation instructions can be found in the Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Installation Guide.

3. Configure end-user package.

Chapter 2 explains how to use the Deployment Configuration Program to create
customized packages for Outlook end users. These packages can be configured to
install the necessary software on user desktops, or to convert users’ existing
Outlook and Exchange data files for use with the new software—or both,
depending on your circumstances.

4. Deploy each end-user package.

Once you have created an installation package for your users, you must tell them
where to find it and how to use it. Many administrators simply copy the package
and the associated Sun Java System Connector for Microsoft Outlook 7 2005Q4 User’s
Guide to a shared folder, and then provide links to the installation package and
documentation in an announcement email to users.

Steps 1 and 2 of this process overview are a good place to start regardless of your
unique configuration and preferences. If your migration strategy calls for two or
more different installation packages for different users or user groups, simply
repeat steps 3 and 4 for each package until all users have been migrated.

Steps
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The deployment process can proceed along different paths depending on your
original and destination network configurations, the administrative structure of
your organization, and your own informed sense of the extent to which your users
should be involved in the process of installing and configuring their own desktop
software. Moreover, your network configuration or preferences may dictate some
variation to the standard scenario described above. Chapter 3 provides application
notes for the most common of these variations.

Chapter 1 • Getting Started 15
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CHAPTER 2

Configuring End-User Packages

If the most recent version of the Administrator’s software is not yet installed on your
computer, see the Sun Java System Connector for Microsoft Outlook 7 2005Q4 Installation
Guide. The Administrator’s software must be properly installed on your computer
before you can run the Deployment Configuration Program.

Creating Desktop Installation Packages
Follow these instructions to create a single desktop installation package for a single
user, or for a particular group of users who will all install and configure the Connector
for Microsoft Outlook in the same way. To create multiple desktop installation
packages with a variety of configuration settings for different groups of users, simply
repeat this procedure for each package you want to create.

� To create an end-user desktop installation package

1. Locate and launch (double-click) the file Admin.exe, in C:\Program
Files\Sun\Deployment Configuration Program\, or from a desktop
shortcut icon or from the Start program menu.

The Deployment Configuration Program then opens its Configuration Window on
your desktop, as shown in Figure 2–1.

Steps
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FIGURE 2–1 Deployment Configuration Program: Configuration Window

The Configuration Window contains:

� nine tabbed panels where you will enter the information to characterize an end
user’s configuration of the Connector for Microsoft Outlook (described
separately below).

� a Help button, which opens a separate window of information about the entry
options available on the currently displayed panel.

� three menus: File, Tools and Help.

The File Menu offers several standard, familiar Windows features for file
management: New, Open..., Save, Save As..., Print Setup..., Print..., and Exit.

The Help Menu offers context-sensitive access to the online Help system that
accompanies this Deployment Configuration Program.

The Tools Menu offers a Create Package feature that lets you create a new
installation package for an existing .ini configuration file that has been
opened into this Configuration Window. You may use File→Open... to locate
and open an existing .ini file.

2. Complete the information in the nine tabbed panels, as described separately (per
tab) below. Click on each tab to display the associated panel.

If you begin creating an installation package but then decide to finish it at a later
time, you may File→Save a partially completed package, and then File→Open... it
later to resume and complete your work.

3. When you have entered all of the information requested in all nine tabbed
panels, select File→Save to save your configuration choices in an .ini file and
create a new installation package. Your Save command activates a standard,
familiar Windows Save dialog box.

4. In the dialog box: Enter an appropriate path and filename for the .ini file and
.exe file, and click the Save button.

The Save command actually creates two new files: the .ini file, which is saved to
whatever folder you designate in the Save dialog box, and an .exe file (the
bundled installation package, including a copy of the .ini file), which is saved by
default to C:\Program Files\Sun\Deployment Configuration
Program\Packages. Both the .ini and .exe files carry whatever filename you
designate in the Save dialog box.
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If the program reports a Logon failure or “Could not locate...” a necessary resource
while it is running. If you know that the resource exists in the location you have
specified, then the administrator account you are using to run this Deployment
Configuration Program is not authenticated to the file server where the resource
resides. Make sure that you are logged in to the locations of all such resources and
then run the Deployment Configuration Program again.

Processes Tab
The Processes tabbed panel is shown in Figure 2–2.

FIGURE 2–2 Deployment Configuration Program: Processes Tab

Troubleshooting

Chapter 2 • Configuring End-User Packages 19



User mode
These two options, Silent installation vs. Interactive, are mutually exclusive:

Silent: The user program will install and configure the user’s software, and convert the
existing default Exchange user profile and existing Personal Folders (.pst) files,
without any user involvement whatsoever, according to the administrator’s pre-set
parameters for this process (as set in this and the other tabs in this Deployment
Configuration Program).

Interactive: The user program will present the user with at least some choices for the
installation, configuration and conversion processes. The extent of user involvement
will be as determined by the administrator (as set in this and the other tabs in this
Deployment Configuration Program).

Processes to include in this configuration
The installation of these software components to user desktops will require access
privileges that often are disallowed to many or most end users. If your network serves
“locked-down” Windows environments where end users cannot install software, we
strongly recommend a “push” method for software distribution from the system
administrator to user desktops that bypasses the requirement for user access
privileges. This “push” method of distribution is explained in ““Push” Method
Deployment, If End Users Lack Installation Privileges” on page 39.

For a full explanation of any or all of the processes offered in this panel, and the
implications of installing or not installing them, please see “Deployment Toolkit
Components” in Sun Java System Connector for Microsoft Outlook 7 2005Q4 Deployment
Planning Guide of the Sun Java System Connector for Microsoft Outlook 7 2005Q4
Deployment Planning Guide.

Install or upgrade Sun Java System Connector for Microsoft Outlook. Tells the
program to install the software that facilitates the necessary ongoing communications
between the user’s Outlook client application and the Sun Java System server. If Sun
Java System Connector for Microsoft Outlook is already installed, the user program
will check the installed version and, if appropriate, upgrade to the newer version.

System requirements for the Sun Java System Connector for Microsoft Outlook
include:

� Operating System Windows 2000 (Service Pack 3 or higher) or Windows XP
(Service Pack 1 or higher).

� Outlook 2003, or Outlook 2002 with Office XP Service Pack 2 or higher, or Outlook
2000 with Office 2000 Service Pack 3 or higher

� Microsoft Outlook must be designated as the user’s default email client. If Outlook
is not set as a user’s default email client, see “Designating Outlook as the Default
Client” on page 47 resolve this problem.
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� The software cannot be installed to any workstation that also contains the Sun Java
System Synchronization program (previously known as the Sun ONE Sync
program), which is incompatible with Connector for Microsoft Outlook. If the Sun
synchronization program has been installed on a particular user’s desktop, it must
be removed (see “Removing Sun Java System Synchronization” on page 48

The Sun Java System Connector for Microsoft Outlook Setup Wizard will detect any
discrepancy between these requirements and the actual installation environment, and
in that case will not install Sun Java System Connector for Microsoft Outlook.

Install or upgrade Microsoft Web Publishing Wizard. Tells the user program to
install Microsoft’s Web Publishing Wizard (WPW), which makes the user’s Free/Busy
information available to the Sun Java System Calendar Server. If WPW is already
installed, the user program will check the installed version and, if appropriate,
upgrade to the newer version. If you mark this checkbox, you must also specify the
network location of the installation kit for the Web Publishing Wizard.

Create/convert/upgrade user profile. Activates the User Profiles tabbed panel, so the
user program can convert an existing eligible Outlook user profile or create a new
profile for use with the new Sun Java System Connector. The user program will
convert only an “eligible” profile, meaning that the profile must:

� include message services of at least one type designated in the User Profiles tabbed
panel (in the Converted/upgraded Profile Settings section), and

� not have been fully converted (all of its .pst files converted) by a previous run of
the user program (although the remaining, unconverted .pst files of a partially
converted profile can be converted).

If this box is not marked, the entire User Profiles tabbed panel will be grayed out and
unavailable, and no user profile will be converted or created. For example, you may
want to create a user installation package to simply install or update MAPI services
without converting or creating any profiles.

Log file settings
These settings pertain to the directory where the user program will write its log files
for the user’s migration session. The first two radio-button options are mutually
exclusive:

� Store log files locally: Tells the user program to write its log files to the user’s local
“temp” directory.

� Store log files in a shared directory: Tells the user program to write its log files to a
particular shared directory, which you must specify in the accompanying text box.
Use the Browse (“...”) button to locate and specify the path, or just type it into the
text box. You can enter a drive letter or a UNC path.

If the Browse feature for Log files does not display the location you need to specify (but you
know that it exists): This is an unlikely scenario, but chances are you simply are not
authenticated in the domain to which you have browsed. To correct this problem,
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right-click the target computer and select Explore, and then enter your
administrator userID and password at the prompt. You may then return to the
Browse feature and select the computer you need to browse.

� Include debug logging: Tells the user program to log its activities in the more
verbose, more explicit “debug” style. If a user encounters a problem with the
installation package and you can’t diagnose the problem by reviewing the
default-style log entries, the more verbose debug-style logging may provide
enough additional information to help you or your associates solve the problem.
This option is off by default.

Status file settings
Post a one-line status of user activity to a .csv file: Adds a one-line summary of user
activity to the .csv file you specify in the accompanying text box (below). Each line
represents one run of the desktop tool by one user. A single user who runs the tool
multiple times should generate multiple lines in the .csv file.

If you mark this checkbox, you must also specify the shared file to which the status
lines will be written. Use the Browse (“...”) button to locate and specify the path, or
just type it into the text box. If the file already exists, it will be updated each time the
installation kit is run.

Notes (optional)
Any notes or comments you care to include about this configuration can be entered
into this field.

User Profiles Tab
The settings in this User Profiles panel, shown in Figure 2–3, apply only if this package
will create or convert user profiles. Therefore, the features in this panel are available
only if the Create/convert user profile option is checked on the Processes tabbed
panel. This entire User Profiles panel will be grayed out if the
Create/convert/upgrade user profile option is unmarked.
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FIGURE 2–3 Deployment Configuration Program: User Profiles Tab

The settings in this panel determine how Exchange users’ Contacts, Journal and Notes
data will be converted to local (desktop) Sun Java System Connector Personal Folders
(.pst) files.

User profile settings
Mark options in this section to specify whether and how user profiles will be
converted and created:

� Convert/upgrade existing eligible user profiles: Tells the user program to convert
an existing Outlook profile, as follows:

� In Silent Mode: Converts the user’s default profile if it can be found, or does
nothing if a default profile cannot be found.

Chapter 2 • Configuring End-User Packages 23



� In Interactive Mode: Prompts the user to select a single profile to convert if it
finds two or more eligible profiles connecting to Exchange server(s), or finds
only one eligible profile that is not set as the user’s default. If the program finds
only one eligible profile, and it is set as the user’s default, the program
automatically converts that profile without any user interaction. If the program
finds no eligible profiles, it does nothing— neither converts nor creates any user
profile.

Remember that the user program will convert only an “eligible” profile,
meaning that the profile must include message services of at least one type
designated in the Converted/upgraded Profile Settings section of this screen
(below), and must not have been fully converted (all of its .pst files converted)
by a previous run of the user program (although the remaining, unconverted
.pst files of a partially converted profile can be converted).

� Create new user profiles without conversion/upgrade: Tells the user program to
create a new Outlook user profile, ignoring any existing profiles that may already
exist for the user. It will create only one new profile for a given user, even if the
user runs the installation two or more times.

� Convert/upgrade or create: Tells the user program to convert an existing Outlook
user profile if it can find one, or create a new profile if it cannot find an existing
one:

� In Silent Mode: Converts the user’s default Outlook profile if it can be found,
or creates a new profile if a default profile cannot be found.

� In Interactive Mode: Prompts the user to select a single profile to convert if it
finds two or more eligible profiles connecting to Exchange server(s), or finds
only one eligible profile that is not set as the user’s default. If the program finds
only one eligible profile, and it is set as the user’s default, the program
automatically converts that profile without any user interaction. If the program
finds no eligible profiles, it creates a new one.

Converted/upgraded Profile Settings
Special Note for Version Upgrade: For any users running this package who are upgrading
from Sun Java System Connector version 6 to version 7, the user program will ignore
any server-parameter changes that may be entered on the Servers panel— except for
the Address Book Server, since it is new in version 7. The program will, however,
apply any server-parameter changes to any of the other types of converted profiles. If
you want to change any server parameters for users who are upgrading, you should
create a separate package for those users and set it to Create new user profiles ...
(under User profile settings above).

� If converting/upgrading, select the types of profiles eligible for
conversion/upgrade: Checkmark the box(es) that correspond to the profile type(s)
that the user program should consider “eligible” for conversion. Remember that an
“eligible” profile must include message services of at least one type designated
here, and must not have been fully converted (all of its .pst files converted) by a
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previous run of the user program (although the remaining, unconverted .pst files
of a partially converted profile can be converted).

The “Upgrade Version 7.0 Sun Java System Connector for Microsoft Outlook
profiles (GAL Support)” corresponds to the removal of the Microsoft LDAP
provider. The new GAL feature replaces Microsoft LDAP. This option does not
perform any data migration.

Note that different types of data associated with different profile types are migrated
differently, as shown in the table below.

— Migrating From—

Exchange MS POP MS IMAP SJSC 6

Mail Not
Migrated(server
data)

SJOC-local.pst SJOC-local.pst Not Migrated
(server data)

Contacts Addr Bk Server Addr Bk Server Addr Bk Server Addr Bk Server

Calendar Not
Migrated(server
data)

CalendarServer CalendarServer Not
Migrated(server
data)

Tasks Not
Migrated(server
data)

CalendarServer CalendarServer Not
Migrated(server
data)

Sticky Notes SJOC.pst SJOC.pst SJOC.pst SJOC.pst

Journals SJOC.pst SJOC.pst SJOC.pst SJOC.pst

� If converting/upgrading, change the profile name to the following: The name by
which the converted profile will be identified in the drop-down list box that
appears on Outlook’s user logon screen.

Created Profile Settings
These options apply only to new profiles that the user program will create, and not to
converted or upgraded profiles.

� Name for new profiles: The name by which the new profile will be identified in
the drop-down list box that appears on Outlook’s user logon screen.

� Set new profile as default: If this box is checked, the new profile will be set as the
user’s default Outlook profile.
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Option to save profile user password during
configuration
� Give user the option to save: Tells the user program to display a checkbox that lets

the user choose whether Outlook should prompt the user for a password upon
each login, or save (“remember”) the password so the user can skip that login step.
Within the user program, the instructions displayed with the checkbox explain: “If
checked, you will not need to enter your information each time you launch
Outlook.” This option is not available in any user package configured to run in
Silent mode.

� Always save: Tells the user program to not offer the user the choice described
above (for Give user the option...). Instead, the screen will display this message:
“Your password will be saved. You will not need to enter your password each time
you launch Outlook.”

� Never save: Tells the user program to not offer the password choice, and to
configure Outlook to always prompt for the user’s password, by default. The user
program will display no checkbox or related explanatory text.

User .psts Tab
The settings in this User .psts panel, shown in Figure 2–4, define how the program will
save users’ Personal Folders (.pst) files. Depending on your choices in other panels in
this program, certain sections of this screen may not apply and may appear
grayed-out (unavailable) in the display.
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FIGURE 2–4 Deployment Configuration Program: User .psts Tab

General Settings for Personal Folder (.pst) Files
Size for new Sun Java System Connector ... .pst: ____ MB: The expected amount of
disk space required for the new .pst file into which selected items from the old
Exchange server are copied. The user program aborts the conversion if a user does not
have this much disk space available. Leave this value set at its default unless you have
some particular reason to expect that your .psts will be larger.

Exchange Profile Settings for .psts
Migrate Exchange server Contacts to Sun Java System Address Book Server: Tells
the user program to migrate the user’s Exchange Contacts and copy them to the Sun
Java System Address Book Server. If this option is unmarked, no Exchange Contacts
will be migrated.

Update ALL addresses to SMTP format: Tells the user program to convert all
addresses that occur within Personal Folders (.pst) files to SMTP (Internet standard)
format.
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By default, automatically convert a .pst if file is smaller than: ____ MB: In Silent
mode: The user program will ignore (not convert) any .pst files larger than or equal
to the size specified here. In Interactive mode: If any existing .pst files are larger than
or equal to the specified size, the program will prompt the user to specify which (if
any) of the large files to convert.

Auto-minimize setup wizard and convert .psts in the background, if total size of all
.psts exceeds: ____ MB: This setting is irrelevant in Silent mode. In the Interactive
mode, if the total size of all .pst files to be converted exceeds the size specified here,
the user program will convert the profiles first, and then automatically minimize itself
to the user’s Task Bar to convert the .pst files as a background process. Once the
profile has been converted, the user can run Outlook and access the converted profile.

Password-protected Exchange .psts: Choose one of these mutually exclusive options
for converting password-protected .pst files:

� Prompt user for password and convert (not an option in Silent mode): Tells the
user program to prompt the user for the password to open each .pst file and
convert it.

� Do not convert but keep old .pst in profile: Tells the user program to not convert
the .pst file, but to keep the unconverted .pst file in the profile.

� Do not convert and remove from profile: Tells the user program to not convert the
.pst file, and to remove the unconverted .pst file from the profile. (The old .pst
file is not, however, physically deleted from the user’s hard drive.)

IMAP/POP Profile Settings for .psts
Migrate POP/IMAP .pst Calendar and Tasks to Sun Java Enterprise Server: Tells the
user program to migrate the user’s POP/IMAP calendar data and tasks to the Sun
Java Enterprise Server. If this option is unmarked, no calendar data or tasks will be
migrated. Note that Contacts are migrated by default, so no settings are needed for
Contacts.

Associate all existing desktop data with the new Sun Java System Connector for
Microsoft Outlook profile: Tells the user program to associate the user’s existing
POP/IMAP desktop data with the new Sun Java System profile. If selected, the local
.pst file is not deleted.

Servers Tab
The Servers tabbed panel is shown in Figure 2–5.
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FIGURE 2–5 Deployment Configuration Program: Servers Tab

Settings
Server Name: The host name for each Sun Java System server: Incoming Mail,
Outgoing Mail, LDAP (Global Address List and User Settings), Address Book,
Calendar, and Free/Busy.

Port: The default port number for each server. The default changes if you use SSL to
connect to the server.

Use SSL: Mark this box to require an SSL to connect to the associated server.
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Note – If the Use SSL box is not marked for the Calendar server, the Free/Busy server
values will be the same as for the Calendar, and the Free/Busy line will therefore be
grayed out in this panel. But if Use SSL is marked for the Calendar, then you must
specify a different port for Free/Busy.

Default: Restores all Port numbers back to their original default values (if you have
changed the values but now want to restore the defaults). The default values for SSL
vs. non-SSL are different, and this feature will restore the appropriate default for any
given server depending on whether the Use SSL box is marked.

Mail Tab
The Mail tabbed panel is shown in Figure 2–6.

FIGURE 2–6 Desktop Deployment Configuration Program: Mail Tab
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Incoming Mail (IMAP)
Offline settings (two options, mutually exclusive):

� Download messages locally to Inbox when going offline: Configures mail server
to download messages to the user’s Inbox when the user goes offline. Alternatively,
the user can set the caching status of a given mailbox by highlighting the folder
entry in Outlook, then executing the Properties menu, pressing the Mail tab, and
turning on the Cache all message parts (attachments) for this folder option.

� Do not download messages locally if they are larger than: ____ KB: The
per-message size limit for the message server’s local message cache. This option is
intended primarily to reduce download times when the user goes into offline
operations. This value, however, will also affect re-display times in online mode,
because the message will have to be re-retrieved if it hasn’t been cached.

Check for new messages every: ___ minutes: This is the interval, in minutes, after
which a server mailbox will be polled for newly arrived messages. If any new
messages have arrived, the mailbox is refreshed and redisplayed in Outlook. If this
field is cleared or set to zero, no polling will be done for this server connection.

IMAP Folder Name Mapping Options: Select either Outlook style or
Communications Express style to indicate which of these two standards the user
program should use to name users’ IMAP folders. Your selection here determines
which of two map files, outlook_folders.map or uwc_folders.map, will be used
to map users’ IMAP folder names. An administrator may, before running this
program, edit these files to suit local requirements, as long as the original filenames
remain the same.

For more information, and instructions on how to manually define the system folders,
see “System Folder Mapping Interoperability With Communications Express” in Sun
Java System Communications Services 2005Q4 Release Notes.

Outgoing Mail (SMTP)
BCC all sent messages to self: Configures the user software to automatically insert the
user’s email address into the BCC field of every outbound message (effectively lets a
sender file a copy of every message sent). The messages are filed within a sender’s
server INBOX, and subsequently will be affected by any server-based message filtering
rules.

Requires authentication: Tells the user software to configure the SMTP Service so as
to require user authentication for outbound SMTP mail.
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LDAP Tab
This LDAP tabbed panel, shown in Figure 2–7, lets you specify the settings for the Sun
Java System LDAP Directory Service.

FIGURE 2–7 Deployment Configuration Program: LDAP Tab

Global Address List
The global address list (GAL) is a read-only MAPI Address book for Outlook users to
view, search, and extract address information of the users, user groups, and calendar
resources stored in the corporate directory. The corporate directory here refers to an
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LDAP server storing user account information including user name, passwords,
contact information, and so on. This enables other authorized users on the same
network to access the information. The Sun Java System Connector for Microsoft
Outlook GAL enables Outlook to display the corporate directory as “Global Address
List” in conjunction with Contacts, personal address book, and any other address book
providers. The GAL provides access to details of individual users, static groups, and
calendar resources stored in the corporate directory.

The backend server or the server that is referred to as the corporate directory can be
any LDAP address book server adhering to the predefined schema. Here the term user
means the individual whose data or information is stored as an entry in the server.

In order to allow browsing of the directory, Connector for Microsoft Outlook utilizes
the Virtual List View (VLV) and server-side sort extension of the directory server. The
directory server must be configured for the VLV index. The VLV index is precisely
defined by a basedn, search filter, sort attribute, and scope. Any mismatch amongst the
settings described below and the VLV index settings on the server results in poor
performance.

Search base (root of LDAP directory): The LDAP distinguished name of the root DN
from where searches are performed.

VLV Search filter: The filter that is used for the VLV to display entries within the
directory.

Advanced search filter: Determines what fields are used when searching for users
within the GAL. You can change this field if you wish to customize the GAL’s Find
dialog.

Name resolution filter: Determines which fields to search when entering a name while
composing a new message. Outlook tries to resolve the name after pressing Ctrl-K or
selecting Tools→Check Names from the menu.

VLV sort attribute: The LDAP sort key for the Global Address List. The default value
is cn.

Search times out after: ___ minutes: Limits directory search times to the designated
number of minutes.

Maximum number of search results returned: Limits the number of entries returned
by a search to the number specified here.

Require authentication: Tells the user program to configure the LDAP Directory
Service so as to require user authentication in the form of a user Distinguished Name
(DN) for each directory query.

� User DN pattern: The elements of the user’s Distinguished Name that, when
assembled, will form the complete DN to authenticate the user’s identity to the
LDAP Directory Service (if authentication is required). For example, to define a DN
consisting of a user ID (uid), an organization unit (ou) and an organization (o):
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uid=%s,ou=people,o=florizel.com. The user’s ID replaces “%s” after
configuration of the user’s profile.

Similarly, to define a DN consisting of a common name, an organization and a
country: cn=Fred Smith,o=florizel.com,c=US.

User Settings
The user settings are used to extract information about the user. This information can
be used to determine “out of office” settings and how the user’s name and email
address is displayed when sending email.

Retrieve user settings from LDAP: Enable this checkbox if you want your user
settings extracted from LDAP.

User DN pattern: The elements of the user’s Distinguished Name that, when
assembled, will form the complete DN to authenticate the user’s identity to the LDAP
Directory Service (if authentication is required). For example, to define a DN
consisting of a user ID (uid), an organization unit (ou) and an organization (o):
uid=%s,ou=people,o=florizel.com.

Warn user at startup when out of office message is turned on: If this checkbox is
enabled, a dialog box appears when Outlook is started warning the user that the out
of office message is turned on. The user can choose to turn off the out of office message
with this dialog.

Retrieve full name and email address from LDAP server: Enable this checkbox if you
want the display of your name and email address updated from the LDAP server.

Calendar Tab
The Calendar panel is shown in Figure 2–8.
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FIGURE 2–8 Deployment Configuration Program: Calendar Tab

Settings
Synchronize Outlook calendar with calendar server every: ___ minutes: Specifies
how often the Outlook calendar will synchronize with the calendar server.

Address Book Tab
The Address Book panel is shown in Figure 2–9.

FIGURE 2–9 Deployment Configuration Program: Address Book Tab
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Sun Java System Address Book Server Settings: Enter the portion of the address
book web client URL that follows the domain root and a delimiting slash character.
The root value appears in the grayed-out text box to the left of this value, drawn from
your Address Book Server entry on the Servers panel.

Outlook Address Book Settings:

� Show this address list first: Select Contacts or LDAP Directory (mutually
exclusive) to indicate which of these two should appear first in the user’s Outlook
Address Book.

� Directory search order: Select Contacts first ... or LDAP Directory first ...
(mutually exclusive) to indicate how Directory searches should proceed.

Single User Tab
The Single User tabbed panel, shown in Figure 2–10, lets you specify and authenticate
the identity of a single specific user. This panel applies only if you are creating an
installation kit for one particular user— e.g., for your CEO, or for some other user
whose unique circumstances warrant a more customized configuration.

FIGURE 2–10 Deployment Configuration Program: Single User Tab

Full name: The “friendly” name associated with the user’s email address. When
sending messages, this name appears in the From box of the user’s outgoing messages.

E-mail address: Specifies the email address that people should use when sending mail
to the user at this account— must be in the format name@florizel.com.
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Login name: Specifies the user’s account name, which must be the same value for both
the IMAP and calendar servers. This is often the same as the part of the user’s email
address to the left of the “at” sign (@).

Password: The user’s account password, which must be a single shared password
used for both the IMAP and calendar servers.

Password confirm: A duplicate field for the user’s account password, required as a
precaution against typographical errors. (This value must match the Password value
above.)

Chapter 2 • Configuring End-User Packages 37



38 Sun Java System Connector for Microsoft Outlook 7 2005Q4 Administration Guide • October 2005



CHAPTER 3

Application Notes for Special
Circumstances

The chapter explains how to deploy Sun Java System Connector for Microsoft Outlook
under certain special circumstances or network configurations.

“Push” Method Deployment, If End
Users Lack Installation Privileges
The Deployment Configuration Program lets an administrator create installation
packages that end users can run to install and configure their own local desktop copies
of the Connector for Microsoft Outlook software. Software installation, however,
requires access privileges that often are disallowed to many or most end users. Most
enterprises therefore implement a “push” method for software distribution from the
system administrator to user desktops that bypasses the requirement for user access
privileges. If your network serves “locked-down” Windows environments where end
users cannot install software, we strongly recommend this sort of automated
configuration management as a way to avoid many individual desktop visits.

This section describes a “push” method for distributing the Sun Java System
Connector for Microsoft Outlook to user desktops using Microsoft’s SMS
administration tools. Remember that the Deployment Configuration program can
prepare desktop installation packages that both install the Connector for Microsoft
Outlook software and convert existing Outlook profiles and data files for use with the
new software. If your users had sufficient administrator privileges to install new
software on their own desktops, you could prepare a single installation package that
would perform both the installation and conversion functions in a single pass. But if
the user who runs the installation package lacks the administrator privileges to install
software, then the installation portion of the package would be unable to run and the
conversion would fail.
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When users cannot install their own software, we have to separate those two tasks so
that the installation function can be facilitated separately by an SMS installation
package. The SMS installation package can then be run on each user desktop by a local
SMS account that has full administrator rights, and is therefore authorized to install
new software on the local desktop. After the necessary software for the Connector for
Microsoft Outlook has been installed, we use the Deployment Configuration Program
to prepare a second installation package to convert any existing Outlook profiles and
data files for use with the new Connector for Microsoft Outlook.

The conversion functions will convert any existing Outlook profiles and data files
associated with the specific user who is running the desktop installation program. But
the SMS account that will run the first installation package is a generic account, with
administrator privileges so that it can install software, but not associated with any
particular user. The installation tasks and conversion tasks must therefore be
performed by two separate installation packages, because the generic SMS account
necessary to physically install the software lacks the user specificity necessary to
convert a user’s existing profile and data files.

A typical SMS “push” scenario consists of the five steps detailed below.

� To Deploy the Push Method

1. Prepare the necessary shared folders.

Create three new shared directories, named LOGS, SJSC, and WPW, on a computer
that is part of the same SMS site as the end-user desktops. The nature of Windows
NT local accounts requires that you assign full control share permissions for all
three folders for the SMSCliToknLocalAcct$ account, as shown in the Permissions
window (left) in Figure 3–1 below.

These assignments will provide the necessary read/write access to these directories
for the SMS local account (which requires a password), and lets you avoid having
to open the system to guest access. Also, assign full control permissions for all
three of the NTFS folders to SMSCliToknLocalAcct$, as shown for the LOGS folder
in the Properties window (right) in Figure 3–1.

Steps
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FIGURE 3–1 Permission Settings (left) and Properties (right) for the LOGS Shared Folder

2. Prepare an installation package to install the necessary software.

Use the Sun Java System Connector Deployment Configuration program
(Admin.exe) to create an installation package that will only install the necessary
software to each user’s desktop, but not convert existing Outlook profiles and data
files. The Admin.exe program is described inChapter 2, but note these special
requirements, on the Processes tab, for preparing this package for SMS distribution:

� Be sure the User mode is set to Silent.
� Be sure to uncheck the option to Create/convert/upgrade user profile.
� Use UNC paths (\servername\sharename) for all three of the path fields.

3. Push the first installation package to user desktops via an SMS installation
package.

Use Microsoft’s SMS Packaging Wizard to prepare an installation package that will
contain the Sun Java System Connector installation package you created in step 2,
and then “push” the package to run automatically on user desktops— without any
user initiative or interaction.

a. Launch the SMS 2.0 Management console. Right-click on the collection to
which you want to push the Connector for Microsoft Outlook, and click
Distribute Software. SMS then launches its Distribute Software Wizard.

b. On the Distribute Software Wizard’s Welcome screen: Click Next to begin.

c. On the Package screen: Click the option to Create a new package and
program, and click Next.
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d. On the Package Identification screen: Enter the appropriate values as shown
in Figure 3–2, and click Next.

FIGURE 3–2 SMS Distribute Software Wizard: Package Identification

e. On the Source Files screen: Select Create a compressed version of this source,
and click Next.

f. On the Source Directory screen: Click the Browse button to locate and specify
the directory where the Connector for Microsoft Outlook installation package
was created, as shown in Figure 3–3. The path specification can be either local
or UNC. When you have specified the correct path, click Next.
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FIGURE 3–3 SMS Distribute Software Wizard: Source Directory Screen

g. On the Program Identification screen: Click the Browse button to locate and
specify the name of the program .exe file for the Command line, and click
Next.

h. On the Program Properties screen: Make sure the program will Run with
administrative rights, and click Next.

i. Specify whether and how you want to advertise the program on the next five
screens, titled: Advertise a Program, Advertisement Target, Advertisement
Name, Advertise to Sub collections, and Advertisement Schedule. As you
enter your choices, click Next to advance to each next screen.

j. On the Assign Program screen: Select Yes to assign the program, specify the
date and time of assignment, and click Next.

k. On the Completing... screen: Review your settings for the creation of this
installation package. You may use the Back button to go back and change any
settings now, before you actually create the package. When the settings
appear as you want them, click Finish to create the package, which will then
be pushed to user desktops according to the Assignment and other
parameters you have specified in this Wizard.

A user’s Advertised Programs Monitor will report the package as shown in
Figure 3–4.
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FIGURE 3–4 A User’s Advertised Programs Monitor

In any case, every user will be alerted to the imminent run of the package by a
Countdown dialog box, as shown in Figure 3–5.

FIGURE 3–5 A User’s Countdown Dialog Box

Because the desktop installation program (desktop.exe) will be run by the
SMS administrator program, as a local user, access to network shares will
require a password, even if the shares are made available to the group
“everyone.” If the network denies access to log directories and install
directories during a user run of the installation package, enable guest access on
the computer hosting the log files and installation media, to allow the local
account from one system to access the data from another system.

4. Prepare a second installation package to convert existing Outlook profiles and
data files.

Use the Sun Java System Deployment Configuration program (Admin.exe) to
create a second installation package for the Connector for Microsoft Outlook— this
time to only convert any existing Outlook profiles and data files for use with the
new Connector for Microsoft Outlook software. The Admin.exe program is
described in Chapter 2, but note these special requirements in the Processes tab for
preparing this package:

� Set the User mode to Interactive.

� Under Processes to include in this configuration:

� Be sure that none of the Install or upgrade... options is marked.
� Mark the Create/convert/upgrade user profile option.
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5. Push the second installation package to user desktops via an SMS installation
package.

Use Microsoft’s SMS Packaging Wizard to prepare another SMS installation
package—this one to contain the Sun Java System installation package you created
in step 4. Use the same settings you used in step 3 above to prepare the first SMS
installation package, except for these differences on the Program Properties screen:

� Program can run: Select the option Only when a user is logged on.

� Mark the User input required option, and be sure that Run with
administrative rights is unmarked.

This final SMS package will require some user interaction, to reply to password
prompts, but will not require administrator privileges since this package does not
install any new software to the desktop. The passwords will authorize the
conversion program’s access to password-protected Outlook Personal Folders (.pst)
files.

Alternatively, this step 5 can be accomplished by running the installation package
from the command line, with an SMS script, as explained below under
“Command-Line Switches for the User Installation Package” on page 45

Command-Line Switches for the User
Installation Package
Step 5 of the “push” method described above (see ““Push” Method Deployment, If
End Users Lack Installation Privileges” on page 39 installation package from an SMS
script, with command-line switches to pass the necessary user passwords to the
conversion program as it runs. This would make possible a truly silent installation and
configuration, requiring no user interaction whatsoever.

For example, you might create an SMS package that runs a conversion package, and
have the SMS services issue the following commands when it is run:

DT_Package.exe
/USERNAME=bcarpenter
/PASSWORD=password
/FULLNAME="Burns Carpenter"
/EMAILADDRESS="burns.carpenter@florizel.com"
/DN="uid=bcarpenter,ou=people,o=florizel.com,o=florizel.com"
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Note – This and other command-line samples are formatted here for ease of reading,
but all of the switches must be typed in one continuous string— which is likely to
wrap to multiple lines of its own accord.

You could then substitute environment variables for the users (assuming that the NT
usernames and the iPlanet usernames match):

DT_Package.exe
/USERNAME=%username%
/PASSWORD=password
/FULLNAME="Change This"
/EMAILADDRESS=%username%@florizel.com
/DN=uid=%username%,ou=people,o=florizel.com,o=florizel.com

This command-line approach would permit a silent (or minimally interactive)
installation from SMS, which would probably generate far fewer Help desk calls than
asking users to click a link in an email and requiring users to enter data.

The installation package will support these command-line switches:

� /USERNAME=xxx, where xxx is the username on the Sun servers.
� /PASSWORD=xxx, where xxx is the password on the Sun servers.
� /FULLNAME=xxx, where xxx is the display name of the user.
� /EMAILADDRESS=xxx, where xxx is the email address of the user.
� /DN=xxx, where xxx is the user DN on the Sun servers.
� /NEWPROFILENAME=xxx, where xxx is the name of the created profile.
� /SAVEPASSWORD=n, where n = 1 (save) or 0 (don’t save).

These switches will be useful if you are converting an Exchange profile:

� /OLDDOMAIN=xxx, where xxx is the Exchange domain
� /OLDUSERNAME=xxx, where xxx is the Exchange user name
� /OLDPASSWORD=xxx, where xxx is the Exchange password

Migrating Terminal Service Users from
Exchange to the Sun Java System
The Connector for Microsoft Outlook administrator’s tools can also be used to migrate
existing Outlook users of Windows terminal service from Exchange to a Sun Java
System server. The method described below assumes the following environment:

� Windows 2000 Server with Terminal Services.
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� Office 2000 installed with Terminal Services install file from Office 2000 Resource
Kit CD (ORK) onto the Windows server.

� Outlook 2000 configured as the default mail client.

� To Migrate Terminal Service Users from Exchange
to Sun Java System

1. Prepare the server.
Log onto the server’s local console as an administrator, and configure Outlook to
be the default mail client (if it is not already). Then install Web Publishing Wizard
and the Connector for Microsoft Outlook.

2. Create an appropriate desktop installation package.
Use the Deployment Configuration Program to create a desktop package that does
not install any services, but simply converts profiles from Exchange to Sun Java
System services. (If the user has been in a non-Exchange environment, there will be
no profile to convert, so you must configure the desktop package to create a new
Sun Java System profile instead.)

3. Update the user’s desktop.
Log on to a terminal session as a regular user, and run the desktop installation
package that you created in step 2 above— that only converts or creates a user
profile, but does not attempt to install or update any services. Then open Outlook
and verify that the conversion is complete.

Designating Outlook as the Default
Client
Sun Java System Connector for Microsoft Outlook can be installed only at
workstations where Microsoft Outlook is set to be the default email client. If Outlook
is not set as a user’s default email client, the Setup Wizard will not install the software,
and will prompt the user to correct the problem and run the Setup Wizard again.

� To Designate Microsoft Outlook as a User’s Default
Email Client

1. Open the Windows Control Panel. If you are running Windows XP (only): Select
“Switch to Classic View.”

Steps
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2. Double-click on Internet Options.

3. Select the Programs tab from the Internet Properties window.

4. Select Microsoft Outlook from the E-mail pull-down menu.

5. Click OK.

Removing Sun Java System
Synchronization
The MAPI services for the Connector for Microsoft Outlook are a required component
of the Connector installation, but cannot coexist with the Sun Java System
Synchronization program (previously known as the Sun ONE Sync program). If one of
these Sun synchronization programs is installed on a user’s workstation, the Setup
Wizard will notify the user of the problem (in an error message after the Welcome
screen), and prompt him or her to acknowledge the notice and exit the program. The
user may then rerun the Setup Wizard after the synchronization program has been
removed.

� To Remove a Synchronization Program from a
User’s Workstation

1. From the Start menu: Select the Uninstall... option for the program you want to
uninstall. Choose one of:

� Programs→Sun Java System Synchronization→Uninstall Sun Java System
Synchronization

� Programs→Sun ONE Synchronization→Uninstall Sun ONE Synchronization.

2. In the Uninstallation window: Follow the prompts to uninstall the software.

3. Click Finish to complete the uninstallation process.
To synchronize a Palm device, WinCE device or Pocket PC device with Outlook,
we strongly recommend that users use the sync software distributed with their
devices, rather than the Sun synchronization software. Changing to the sync
software distributed with a device may require uninstalling and reinstalling the
Palm Desktop software.

If a user wants to continue using the Sun synchronization software to sync to the
data of the other device, he or she can reinstall the software, but not select the
checkbox for the Microsoft Outlook 98/2000 translator during the installation.
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Undoing (Reversing) a User’s Migration
To abandon a user’s connection to the new Sun Java System server and restore the
user’s mailbox to service with the old Exchange server:

� To Reverse a User’s Migration

1. Delete the profile “Xxx (old).”

2. Copy the profile “Xxx” to “Xxx Sun“— or some other name, like “Xxx (new),”
etc.

3. Delete the profile “Xxx.”

4. Copy the profile “Xxx (Backup)“ to “Xxx.”

5. Delete the profile “Xxx (Backup).”

6. Determine where the .pst’s are located by viewing Properties on the profile.

There is no standard location for .pst files, so the only reliable way to find them is
to open the profile (now named “Xxx”) and, for each .pst service, click on
Properties and note the path.

7. For each pst file: Rename Yyy.pst to Yyy.new, and rename Yyy.bak to
Yyy.pst.

8. Determine where the .pab’s are located by viewing Properties on the profile.

There is no standard location for .pab files, so the only reliable way to find them is
to open the profile (now named “Xxx”) and, for each .pab service, click on
Properties and note the path.

9. For each pab file: Rename Zzz.pab to Zzz.new, and rename Zzz.bak to
Zzz.pab.

The Yyy.bak and Zzz.bak files will be in the same directory.

To remove the Sun Java System profile and leave the Exchange profile resident on
the system, skip step 2 (and combine steps 1 and 3).
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user installation package, deploying, 14
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